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Résumé


L’outil gratuit d’animation et de graphisme 3D

Logiciel libre de référence pour la création d’images et l’animation 3D, Blender n’a rien à envier à Cinema 4D, 3ds Max ou Maya. Grâce à son interface intelligente et contextuelle, il permet à l’artiste d’allier productivité et créativité. Très ouvert, il met à sa disposition de nombreux moteurs de rendu photoréaliste et s’intègre, par sa richesse et sa flexibilité, à la panoplie des outils de travail quotidiens du graphiste professionnel.

La neuvième édition de ce livre correspond à la version 4.5 de Blender, avec son moteur de rendu Eevee entièrement réécrit pour illuminer vos scènes de façon ultraréaliste, et des outils aux performances largement améliorées pour créer des paysages et des objets toujours plus complexes.

Cette nouvelle édition s’adresse aussi bien aux débutants qu’aux dessinateurs aguerris.

Libérez vos images et animations 3D !


	
•Modélisez de façon puissante les objets, les composants mécaniques et les formes organiques.

	
•Maîtrisez la modélisation polygonale et les outils de sculpture interactive les plus avancés.

	
•Simulez et animez des personnages, fluides et corps souples (vêtements, fourrures et chevelure que vous pouvez sculpter et coiffer), feux et fumées.

	
•Habillez-les par des matériaux et des textures peintes ou photographiées.

	
•Jonglez avec l’éditeur de nœuds pour concevoir des shaders complexes et créer des effets spéciaux.

	
•Illuminez vos scènes avec réalisme et effectuez le rendu en temps réel grâce à la nouvelle version de Eevee et l’amélioration des performances de Cycles.

	
•Montez vos animations directement dans Blender.

	
•Perfectionnez vos animations 2D grâce aux dernières évolutions de l’outil Grease Pencil.



En bonus

Pour accompagner l’ouvrage, téléchargez les nouveaux exercices, mais aussi de nombreuses textures et matériaux, ainsi que des films inspirants.

Configuration recommandée

• 64 bits, Quad Core CPU

• 16 Go de RAM

• Écran Full HD 24 bits

• Souris 3 boutons

• Carte graphique OpenGL avec 4 Go de RAM

Échangez et exportez vos créations vers les autres applications 3D et moteurs de jeux (Unreal Engine, Unity, Fbx, USD, glTF...)

L’auteur

Utilisateurs de Blender depuis une quinzaine d’années, Henri Hebeisen, directeur technique pour le cinéma d’animation et auteur de formations vidéo, et Boris Fauret, artiste français, partagent leurs savoirs avec celui d’Olivier Saraja, le créateur de cet ouvrage, pour faciliter l’accès à Blender au plus grand nombre dans les communautés françaises et anglophones.
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Avant-propos





Ce livre possède un format un peu particulier, situé quelque part entre le manuel d’utilisation et le recueil de didacticiels. Il vise à présenter de façon synthétique à peu près tout ce qu’il est possible de réaliser avec Blender, mais aussi à guider pas à pas ceux que les images de synthèse peuvent effrayer, mais qui voudraient malgré tout tenter leur chance. Malheureusement, il n’a pas été possible de tout mettre, référencer et présenter (Blender est un logiciel tellement riche en possibilités !). Aussi parfois, des choix douloureux ont été effectués avant de figer le contenu d’un chapitre.


3DS MAX, MAYA
Vitesse de développement




Le développement de 3ds Max est réputé très lent, certains bogues datant de quatre versions antérieures n’étant toujours pas corrigés. En revanche, dans le passé, le développement de Maya a été plutôt rapide, mais depuis son rachat par Autodesk (l’éditeur de 3ds Max), il convient de s’accorder le temps de juger. Pour sa part, depuis que le code source de Blender a été racheté par la communauté et que le logiciel est devenu libre, le développement de Blender a été si rapide que maintenir à jour la documentation est une gageure.





Nous utilisons Blender depuis déjà deux décennies. Durant cette période, nous avons pu constater à quel rythme frénétique se font les ajouts de fonctionnalités – ainsi que les inévitables corrections de bugs et optimisations. Il aura fallu vingt-cinq ans à Blender pour évoluer de la version 2.00 à la 4.50. Une numérotation originale qui masque bien les dizaines de versions intermédiaires et qui ont vu des révolutions dans de multiples domaines, allant des simulations physiques à l’implémentation de divers systèmes nodaux, en passant par des refontes massives de l’interface. Souvent raillé par le passé pour sa prise en main jugée rebutante, ou ne serait-ce que pour sa gratuité qui lui conférait de facto un statut de logiciel moins performant que d’autres solutions payantes, Blender a néanmoins su évoluer, se perfectionner et finalement gravir les échelons. C’est un logiciel puissant que nous soutenons bien évidemment avec ardeur et pour lequel nous avons toujours eu le goût de partager nos connaissances, que ce soit au cours de l’âge d’or des forums sur Internet (où nous nous sommes connus !), ou bien lors de formations et d’ateliers d’initiation, ou encore à l’occasion des précédentes éditions de ce manuel. Soutenir ainsi un logiciel en constante évolution se paie donc par une documentation en chantier perpétuel. Et qu’il faut donc sans cesse réactualiser. C’est une tâche que nous a laissée notre ami Olivier Saraja, auteur historique de La 3D libre avec Blender. Et c’est un grand honneur qui nous est fait que de prendre pleinement son relais.


Depuis sa première édition, cet ouvrage a fait son bonhomme de chemin et a été très favorablement accueilli par la communauté francophone des utilisateurs de Blender. Nous avons appris avec fierté (et soulagement !), à travers vos nombreux et chaleureux courriels, que les précédentes éditions avaient pu aider à rendre abordable un logiciel réputé (à tort) comme difficile d’accès. Pour tenir compte tant des progrès de Blender que de sa richesse en perpétuelle expansion, cette neuvième édition ne pouvait attendre davantage. En deux ans seulement, Blender s’est encore étoffé et amélioré pour donner cette version 4.50 : les Geometry Nodes qui offrent un champ incroyable de possibilités en termes de modélisation, le système de simulation de fluide et de fumée qui a été révisé en intégrant Mantaflow, les nombreuses brosses ajoutées au mode Sculpt, la refonte de l’outil Grease Pencil, les outils de modélisation dont l’interface est sans cesse améliorée pour être plus intuitive, la possibilité de créer des assets afin de fluidifier encore davantage vos propres méthodes de travail, le moteur de rendu temps réel Eevee qui voit croître ses possibilités et ses performances, sans oublier le moteur Cycles dont l’optimisation reste inlassablement recherchée ; et tellement d’autres choses qu’il est impossible de les énumérer succinctement.


Blender se transforme mais il reste égal à lui-même : le couteau suisse de la 3D, toujours plus puissant, plus rapide, plus efficace. Pour mieux vous servir.


À qui s’adresse ce livre ?


Blender a été développé en tant qu’outil de production d’animations 3D. Il a donc avant tout un usage professionnel et de production.


Blender n’oublie pas non plus les artistes, en étant très éloigné des outils de conception ou de dessin assisté par ordinateur, précis mais arides et ne favorisant pas la créativité personnelle. Au contraire, l’interface de Blender est vivante, souvent fluctuante même, et semble accompagner l’utilisateur dans ses travaux, lui permettant de se recentrer sur sa liberté artistique plutôt que sur la rigueur nécessaire à un réalisme excessif.


> Vous êtes un curieux ou un débutant


Vous n’avez jamais créé d’images de synthèse et ces mots mêmes vous paraissent mystérieux ou insurmontables ? Vous trouverez dans cet ouvrage une excellente introduction à l’imagerie 3D et, au terme de sa lecture, vous vous sentirez à l’aise et capable de mener, sur la seule base de votre créativité, vos premiers projets.


> Vous êtes déjà un utilisateur confirmé de Blender


Le développement de Blender va vite, très vite, et souvent, les nouveautés ne sont documentées qu’en anglais. Si vous vous sentez dépassé par le déluge de nouveautés de chaque nouvelle version, ou si vous êtes fâché avec la langue anglaise, alors cet ouvrage est également fait pour vous : il reprend toutes les principales fonctionnalités de Blender (des plus anciennes aux plus récentes) en les démystifiant ou en leur apportant un éclairage particulier. Vous apprécierez alors les cas pratiques qui parsèment le livre, à décortiquer jusqu’à ce que vous les maîtrisiez.


> Vous êtes un artiste 3D chevronné


Blender mûrit chaque jour. De plus en plus d’artistes accomplis s’y intéressent ou se tournent vers lui. Outre l’avantage d’être gratuit et de bénéficier d’un développement dynamique, il s’efforce de se doter des outils qui font la force des grandes applications commerciales, pour un coût… nul ! Mais ce qui fait plaisir à lire, ce sont les commentaires d’artistes confirmés qui s’étonnent de voir, par exemple, dans les forums de CGTalk (http://forums.cgsociety.org), des images réalisées avec Blender, en affirmant « [qu’ils ne savaient pas] que Blender était capable de faire ça ! ». L’autre point de satisfaction, c’est de constater que certains ont intégré Blender dans leur workflow, que ce soit pour le dépliage UV ou la simulation des fluides, sans honte d’utiliser un logiciel « gratuit » là où des confrères dépensent des centaines ou des milliers de dollars pour aider leur créativité à s’exprimer. Si vous êtes un artiste 3D confirmé et que vous vous demandez si Blender peut vous aider dans votre démarche artistique ou professionnelle, ce livre est fait pour vous : il brosse dans ses grandes lignes la liste des fonctionnalités et capacités de Blender, en les rapprochant autant que possible de ce qui se fait avec 3ds Max ou Maya, par exemple, afin de faciliter la transition.


REMARQUE Vous êtes familier d’un autre grand logiciel commercial ?




Il serait illusoire d’établir des ponts permanents entre les divers logiciels commerciaux du marché et Blender, mais vous trouverez tout au long de cet ouvrage des apartés expliquant les principales différences ou similitudes entres les fonctions de Blender et celles de 3ds Max ou Maya.





Blender est gratuit… vraiment ?


Oui, vraiment. Vous pouvez le copier à l’envi, le distribuer librement à tous vos amis, collègues et connaissances. Vous pouvez l’installer sur autant de postes que souhaité. Vous n’avez aucune limitation, ni sur son usage, ni sur celui des œuvres réalisées avec lui. Et dans le cas où vous vous sentiriez l’âme d’un développeur, vous pouvez même plonger votre nez dans les sources du logiciel, voir comment fonctionnent ses arcanes internes ou détailler les algorithmes employés : c’est la magie du logiciel libre. Blender est à l’imagerie 3D ce que Gimp est à l’imagerie 2D : un formidable outil de créativité, riche, puissant, fonctionnel et… totalement gratuit !


3DS MAX
Langage de script




Le langage de script de 3ds Max lui est propre et est assez proche du langage C. De son côté, Blender utilise un langage très répandu, Python, qui se révèle puissant et flexible.





D’autres logiciels commerciaux reposent sur quantités de greffons, plug-ins et extensions, la plupart coûteux et difficiles d’accès, pour produire des résultats d’une qualité dépendant grandement de la compétence de l’utilisateur et ce, malgré leur prix. Blender bénéficie pour sa part d’une communauté de développeurs très actifs et dispose d’une solide base de scripts Python (des Add-Ons) qui enrichissent ses capacités naturelles. S’il lui manque une fonctionnalité, il est certain qu’elle est véritablement inutile ou qu’elle sera intégrée dans une très prochaine version officielle !


C’est le moment de clore cet avant-propos et de vous plonger dans la lecture de ce livre qui, nous l’espérons, vous apportera pleine satisfaction !


Toulouse, mai 2025


Henri Hebeisen et Boris Fauret
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Introduction : historique de Blender





L’ancêtre de Blender est né en 1988 au sein du studio d’animation hollandais NeoGeo (l’une des plus grandes sociétés d’animation 3D des Pays-Bas, primée en 1993 et 1995 par l’European Corporate Video Awards), société dont Ton Roosendaal fut l’un des cofondateurs. À la suite d’une intensification des besoins internes, le logiciel fut entièrement réécrit et devint la suite de modélisation et d’animation 3D connue sous le nom de Blender.


En 1998, Ton Roosendaal fonda une nouvelle entité baptisée Not A Number (NaN) dont l’objectif était de développer et de commercialiser Blender : l’ambition était d’offrir un outil compact, multi-plates-formes, professionnel et gratuit, à destination d’un public très large, la société devant vivre de la vente de produits commerciaux et de services. Blender fit sensation à la conférence SIGGRAPH de 1999, s’attirant l’attention du public comme de la presse et confirmant son potentiel hors du commun.


3DS MAX, MAYA
Portabilité




3ds Max n’est disponible que sur plates-formes Windows. Pour sa part, Maya a été porté sous Linux afin de satisfaire aux besoins des studios Dreamworks. Blender, en revanche, est disponible sur à peu près toutes les plates-formes existantes !





En suscitant le même engouement lors du SIGGRAPH de 2000, NaN réussit à réunir près de 4 500 000 euros de financement, qui lui permirent de porter ses effectifs à 50 salariés, aux Pays-Bas, au Japon et aux États-Unis. Au cours de l’été de la même année, la version 2.0 de Blender, intégrant un moteur de jeu, sortait et, à la fin de l’année, Blender pouvait revendiquer plus de 250 000 utilisateurs enregistrés. Après une réduction d’effectif due à la frilosité du marché et la recherche de nouveaux investisseurs, NaN sortait fin 2001 une mouture commerciale de son logiciel, Blender Publisher, visant le marché émergeant du contenu interactif pour les sites web basés sur la 3D. Malheureusement, en raison de ventes décevantes et d’un climat économique de plus en plus difficile, les nouveaux investisseurs décidèrent de mettre un terme aux activités de NaN, signant également celui du développement de Blender.


Reprendre une nouvelle société avec une base suffisante de développeurs salariés n’étant économiquement pas envisageable, Ton décida de créer la Blender Foundation, une fondation à but non lucratif, pour ne pas abandonner la communauté enthousiaste d’utilisateurs et de clients qui pleuraient la disparition de Blender. En juillet 2002, Ton parvint à convaincre les investisseurs de NaN de libérer, moyennant finances, les sources de Blender et lança auprès de la communauté une vaste collecte de fonds devant rapporter les 100 000 euros qui permettraient de racheter les droits de propriété intellectuelle et le code source de Blender aux investisseurs. À la surprise générale, il suffit de seulement sept semaines à la communauté pour amasser cette somme considérable. Officiellement, c’est le dimanche 13 octobre 2002 que Blender fut libéré. Ses fichiers sources furent alors placés sous la licence GNU GPL (General Public License).


Depuis, le développement de Blender continue, poussé par des volontaires dévoués dispersés sur la planète entière et toujours mené par le créateur initial de Blender, Ton Roosendaal. Il est bien évidemment derrière l’essor du Blender Cloud (https://cloud.blender.org), la plate-forme de production ouverte où sont partagés les travaux de contenus 3D, et qui fournit des formations professionnelles. Cette structure s’est fixée pour mission l’amélioration de la création 3D grâce aux logiciels libres/ouverts en produisant des contenus 3D attirants et en permettant aux développeurs et aux artistes de briller par eux-mêmes à travers leurs propres histoires et films d’animation. Une reconnaissance patiemment gagnée qui a permis à Blender d’entrer dans la cour des grands : en 2024, le film d’animation Flow, réalisé avec Blender, se voit récompensé dans de nombreux festivals internationaux.


En parallèle, le financement de la Fondation Blender se poursuit grâce aux donations, à un fonds de développement (auquel contribuent massivement des acteurs majeurs du jeu vidéo, comme Epic Games ou encore Ubisoft) ou encore le Blender Store (https://store.blender.org/). Les revenus ainsi collectés permettent à la Fondation d’employer une quinzaine de personnes à temps plein pour travailler sur l’amélioration de Blender. La version 4.5 de Blender, objet du présent ouvrage, est le fruit direct de ce nouveau modèle libre qui permet de placer un logiciel libre et gratuit au cœur des préoccupations des standards majeurs de l’industrie.












chapitre 1



Installation de Blender
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Blender est une suite complète de modélisation, d’animation, de rendu, et même de montage vidéo parfaitement autonome, tout en n’occupant sur le disque qu’une place très modeste en comparaison avec les logiciels concurrents. Aussi simple à installer que compact, ses possibilités sont également extensibles grâce à l’usage de scripts Python ou de différents moteurs de rendu externes avancés, non fournis et non couverts par cet ouvrage.
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Quel que soit votre système d’exploitation de prédilection (Windows, GNU/Linux, macOS), l’installation de Blender ne présente aucune difficulté, et ce logiciel fonctionnera directement, sans configuration particulière de votre part. En effet, même s’il fait usage du langage de programmation Python 3.2 (un langage interprété, qui permet d’étendre, grâce au scripting, les capacités de Blender en termes de modélisation, d’animation ou de gestion de scènes complexes), toutes les bibliothèques nécessaires sont fournies avec le logiciel. Vous n’aurez donc pas à installer le langage Python, sauf si vous prévoyez d’écrire vous-même vos propres extensions, ce qui n’est pas couvert par cet ouvrage.


Les principales étapes sont reprises ci-après, avec des explications un peu plus détaillées pour l’utilisateur de Windows, parfois moins à l’aise avec les outils informatiques.


Installation sous Windows


Blender n’est disponible qu’en version 64 bits ; il vous est donc nécessaire de savoir quelle est la version de votre système d’exploitation. Cependant, si votre ordinateur à moins de 10 ans, il est vraisemblablement sur un système d’exploitation 64 bits. Plusieurs méthodes d’installation sont systématiquement proposées : un fichier auto-extractible .msi, dont l’assistant vous guidera pas à pas à travers toutes les étapes de l’installation, une installation via le magasin d’applications Microsoft, ou un fichier .zip à désarchiver à l’emplacement de votre choix.


La seconde méthode est la plus directe et c’est celle que nous présenterons ici. Vous devez bien sûr télécharger la version correspondant à votre système, même si l’exemple traité ci-après correspond à une version 64 bits.


Téléchargez le dossier d’installation, disponible à l’adresse suivante https://​download.​blender.​org/​release/​Blender​4.4/​blender-​4.4.0-​windows-​x64.zip


Décompressez l’archive .zip (effectuez un clic droit sur le dossier de l’archive et choisissez Extraire tout...). N’hésitez pas à déplacer le répertoire blender-0.0-windows-x64 à un endroit plus approprié de votre disque dur si nécessaire. Enfin, double-cliquez sur le fichier blender.exe pour lancer l’application.


BON À SAVOIR
Windows ARM




Depuis quelques années, Blender propose une version native pour les processeurs ARM sur Windows. Blender est donc capable de fonctionner sur les tablettes Surface, ainsi que sur les derniers ordinateurs portables qui tournent avec des processeurs ARM.





Installation sous GNU/Linux


Pour Linux, Blender est proposé en version 32 bits et 64 bits, pour des distributions plutôt récentes (à base de glibc 2.11).


À noter que si la plupart des distributions proposent une version de Blender qui lui est parfaitement adaptée, celle-ci aura probablement quelques numéros de version de retard par rapport à celle proposée par la Fondation Blender. Nous ne présenterons donc ici, pour les besoins de notre exemple, que la méthode d’installation de la version officiellement distribuée sous forme d’archive .zip et en version 64 bits.


Sélectionnez la version qui vous convient le mieux en fonction de votre système et téléchargez-la sur le site officiel de Blender (https://​download.​blender.​org/​release/​Blender​4.4/​blender-​4.4.0-​linux-​x64.​tar.xz).


BON À SAVOIR
Blender et OpenGL




Blender utilise OpenGL pour tous les tracés à l’écran des fenêtres 3D jusqu’aux menus et aux boutons. Une carte graphique autorisant l’accélération 3D matérielle vous permettra donc d’utiliser Blender de façon optimale. Les moins bien nantis ne seront toutefois pénalisés que pour les scènes les plus complexes.





Ensuite, suivez la procédure suivante :




	
1Ouvrez une console.


	
2Décompressez l’archive : tar jxvf blender-4.4.0-linux-x64.tar.xz.





Pour lancer Blender, il suffit de poursuivre avec les étapes suivantes :




	
3Allez dans le dossier créé : cd blender-4.4.0-linux-x64.tar.xz.


	
4Tapez ./blender.





En fonction de votre gestionnaire de fenêtres, vous pouvez créer une icône sur votre bureau pour lancer Blender d’un simple clic de souris.


Il est également possible d’installer Blender via le magasin d’applications Snap sur certaines distributions Linux récentes. Celle-ci se fait alors automatiquement, tout comme les mises à jour éventuelles du logiciel.


OUPS !
Blender ne se lance pas




Vérifiez-en les raisons dans une console. Il est possible que vous deviez installer un paquetage nommé libstdc++5 (ou ultérieur). Une recherche dans les paquets .rpm ou .deb de votre distribution favorite devrait vous permettre de trouver celui-ci. Dans le cas contraire, effectuez une recherche sur Internet : les distributions sont trop nombreuses pour que nous puissions mettre à disposition dans cet aparté les différents liens.





Installation sous macOS


Les derniers binaires officiels proposés par la Fondation Blender requièrent macOS 10.6 ou plus. Il existe désormais deux versions de ces binaires, une pour l’architecture Intel 64 bits et une autre optimisée pour les processeurs Apple Mx des modèles plus récents. Vous pourrez télécharger Blender sur le site officiel (https://​download.​blender.​org/​release/​Blender​3,0/​blender-​3,0,0-​macOS-​x64.dmg).


Naviguez jusqu’à l’emplacement où le fichier a été enregistré et double-cliquez dessus. Une fois le fichier .dmg ouvert, une nouvelle fenêtre apparaît. Pour valider l’installation, il suffit de faire glisser l’icône de Blender sur l’icône du dossier installation.


Blender est installé et prêt à l’emploi. Naviguez dans le dossier Application et double-cliquez sur l’icône Blender pour lancer le logiciel.


En même temps que l’interface du logiciel s’affichera sur votre écran, son icône apparaîtra dans le Dock. Un clic droit (ou [Ctrl]+clic) permet d’en afficher les options : choisissez Garder dans le Dock.




[image: Figure 1–1 Il est possible d’ouvrir le fichier .dmg directement depuis la barre des tâches.]


Figure 1–1
Il est possible d’ouvrir le fichier .dmg directement depuis la barre des tâches.








[image: Figure 1–2 Il suffit de glisser-déposer l’icône pour installer le logiciel.]


Figure 1–2
Il suffit de glisser-déposer l’icône pour installer le logiciel.








[image: Figure 1–3 Blender figure désormais dans la liste des applications.]


Figure 1–3
Blender figure désormais dans la liste des applications.







Les préférences de l’utilisateur


Avec une interface riche et largement personnalisable, les préférences de l’utilisateur seront inévitablement une préoccupation centrale un jour ou l’autre, aussi en livrerons-nous quelques clés dès ce chapitre. Il est possible d’afficher celles-ci au travers du menu Edit>Preferences. Elles apparaissent alors dans une fenêtre flottante, les différents menus étant listés sur la partie gauche.


BON À SAVOIR
Gestion des préférences utilisateurs




La scène de départ par défaut de Blender est un cube gris flottant dans l’espace, avec une caméra et une lampe simple. Vous pouvez préférer une scène de départ plus élaborée, ou totalement vierge. Les deux opérations suivantes peuvent vous y aider.




	
•File>Defaults>Save Startup File enregistre la scène actuellement affichée comme étant la future scène de départ à chaque fois que vous lancez Blender.


	
•File>Defaults>Load Factory Settings réaffiche la scène de départ par défaut de Blender.





Cette dernière opération ne restaure toutefois pas la scène par défaut comme nouvelle scène de départ : après avoir chargé la scène par défaut, il vous faut ensuite la sauvegarder grâce à Save Startup File.





Personnalisation de Blender


Les paramètres de préférences sont regroupés de façon assez conventionnelle ; la plupart sont hérités des anciennes versions de Blender, mais autorisent désormais des réglages plus variés et plus fins.




[image: Figure 1–4 Paramètres de personnalisation de l’interface de Blender]


Figure 1–4
Paramètres de personnalisation de l’interface de Blender






Thèmes de couleur


C’est le cas par exemple de la catégorie Themes, qui permet de personnaliser indépendamment chaque type d’éditeur (3D View, Node Editor, etc.) en spécifiant la couleur de chaque élément constitutif de l’interface graphique (couleur de l’en-tête, des textes, des titres, etc., pour l’éditeur Properties ; de la grille, des points, des arêtes, des facettes sélectionnées, etc., pour l’éditeur 3D View). Le bouton Reset permet de revenir au thème d’origine sans avoir à renoncer aux autres modifications apportées par l’utilisateur à la scène de démarrage par défaut.




[image: Figure 1–5 La couleur de chaque élément de fenêtre peut désormais être modifiée selon les goûts de l’utilisateur.]


Figure 1–5
La couleur de chaque élément de fenêtre peut désormais être modifiée selon les goûts de l’utilisateur.






Paramètres liés aux périphériques d’entrée


Dans la catégorie Input, il est question de gérer le paramétrage de la souris ou du clavier.


La souris


Blender nécessite une souris à trois boutons pour fonctionner de façon optimale. Si votre souris ne dispose que de deux boutons classiques, vous pouvez cocher l’option Emulate 3 Button Mouse pour que la pression simultanée des boutons gauche et droit simule l’activation d’un bouton central virtuel. À noter que cela ne permet pas de simuler le défilement de la roulette.


Le clavier


L’un des points forts de Blender est la pluralité des raccourcis clavier qui, bien maîtrisés, permettent d’augmenter considérablement la productivité de l’utilisateur. Mais Blender est tellement riche en fonctionnalités qu’il est impossible de couvrir, sans les rendre exagérément complexes à mémoriser ou utiliser, toutes les possibilités de façon cohérente avec les raccourcis clavier existants.


BON À SAVOIR
Recherche du raccourci d’une fonction particulière




Dans la catégorie Keymap, un astucieux champ de recherche permet de localiser rapidement un raccourci clavier à partir du nom de la fonction associée. Par exemple, la chaîne de caractères extrude aboutit à l’affichage des catégories Mesh, Curve ou Armature, qui permettent toutes l’extrusion de leurs éléments.





L’agencement actuel se veut optimal et généraliste. Il conviendra toutefois assez mal à des utilisateurs spécialisés dans un domaine (comme la modélisation ou l’animation). À leur attention, Blender permet donc de changer les raccourcis clavier ou de les assigner différemment.


ASTUCE
Vous avez oublié un raccourci clavier ?




Bien évidemment, toutes les fonctions accessibles via les menus situés dans les en-têtes de Blender affichent le raccourci clavier approprié lorsqu’il existe. Toutefois, certains utilisateurs peuvent avoir un trou de mémoire, c’est-à-dire avoir besoin de retrouver un raccourci en un coup d’œil sans avoir à parcourir différentes zones de l’interface graphique. C’est ici que la catégorie Keymap des Preferences permet de retrouver, dans une liste synthétique, le ou les raccourcis recherchés.







[image: Figure 1–6 Chaque fonction peut se voir attribuer un raccourci clavier en fonction de son contexte.]


Figure 1–6
Chaque fonction peut se voir attribuer un raccourci clavier en fonction de son contexte.






Les catégories sont dépliables une à une pour révéler les raccourcis clavier existants. Le bouton Edit permet d’activer le mode autorisant la modification de ceux-ci et le bouton Restore permet de réinitialiser le raccourci à sa valeur originelle. Il est également possible d’exporter sa propre configuration à l’usage de tiers (bouton Export) et, réciproquement, d’importer celles mises à disposition par d’autres utilisateurs (bouton Import).


Franciser l’interface


Blender est un logiciel international, avec une mine de ressources disponibles sur Internet dans diverses langues. Pour faciliter la compréhension et la maîtrise du logiciel pour les masses, la plupart des sites d’éditeurs ont pris le parti de conserver, que ce soit lors des tutoriels vidéo ou écrits, l’interface de Blender en anglais. C’est également le parti pris par cet ouvrage.


Si toutefois vous souhaitez afficher Blender en français, il vous faut aller dans la catégorie Interface et repérer la case à cocher Translation. Vous pouvez dans le menu déroulant choisir la langue par défaut et choisir d’imposer la traduction aussi bien à l’interface qu’aux bulles d’aide (Tooltips), au choix.


Pour bénéficier au mieux des enseignements de cet ouvrage et de la plupart des ressources disponibles sur Internet, nous vous recommandons de ne cocher que Tooltips. Ainsi, vous conserverez la même interface internationale, mais pourrez bénéficier des explications et astuces affichées dans les bulles d’aide dans votre langue maternelle.




[image: Figure 1–7 La francisation totale ou partielle de Blender est possible.]


Figure 1–7
La francisation totale ou partielle de Blender est possible.






Les modules complémentaires (add-ons)


Une grande part de la versatilité de Blender vient de l’intégration intime de greffons, ces scripts externes qui sont distribués avec Blender ou téléchargeables sur différents sites de projet. Ils sont réunis sous l’appellation add-ons, car ils viennent en complément de Blender, pour en étendre les capacités.


Pour des raisons de sécurité (un script malicieux à l’intérieur de Blender pouvant faire beaucoup de dégâts à votre système, entre autres), tous ces add-ons sont par défaut désactivés, et vous êtes invité à n’activer que ceux qui sont livrés par défaut avec Blender ou ceux dont la provenance vous est connue et jugée de confiance. De plus, cela permet de maintenir une interface dotée seulement des fonctionnalités essentielles, toujours propre et bien organisée, sans ralentissement notable.


À partir de la version 4.0 de Blender, un répertoire officiel d’add-ons a été mis en ligne et permet d’accéder à un catalogue d’add-ons et de thèmes personnalisés directement depuis l’interface des préférences utilisateurs de Blender. En plus de la facilité d’installation, ce nouveau système présente plusieurs avantages pour l’utilisateur comme la mise à jour automatique des add-ons ou l’installation automatique des éventuelles dépendances. Les différentes extensions sont accessibles depuis les préférences utilisateurs, onglet Get Extensions. Un simple clic sur le bouton Install permet de télécharger l’extension choisie et de l’activer, sans redémarrage nécessaire.


BON À SAVOIR
Autoriser l’accès à Internet




Pour accéder au catalogue d’extensions ou voir les éventuelles mises à jour, il est nécessaire d’autoriser l’accès en ligne depuis l’onglet System des préférences utilisateurs comme illustré dans la figure 1–8.







[image: Figure 1–8 L’option Allow Online Access permet à Blender de communiquer avec Internet]


Figure 1–8
L’option Allow Online Access permet à Blender de communiquer avec Internet






Les add-ons disponibles sur Internet indiquent souvent comment les installer proprement (souvent, il s’agit de copier le fichier ou le répertoire distribué dans le répertoire scripts/addons de votre installation de Blender), ou vous pouvez alternativement utiliser le bouton Install from Disk pour en réaliser une installation automatique. Ils apparaissent alors dans la liste des add-ons disponibles dans la fenêtre Blender User Preferences.




ASTUCE S’y retrouver rapidement avec les add-ons


La bibliothèque des add-ons distribués avec Blender est plus ou moins conséquente, en fonction du numéro de version de Blender. Un champ de recherche fort commode permet donc de trouver rapidement un add-on dont vous connaissez le nom, même si vous ignorez sa catégorie. Il est également possible, pour plus de lisibilité, d’activer l’affichage des greffons selon que le support est assuré par la Fondation Blender (bouton Official) ou par la communauté Blender (bouton Community).


Une signalétique accompagne également chaque description :




	
•[image: ] indique un add-on en version bêta (en cours de développement) pouvant présenter des dysfonctionnements occasionnels ;


	
•[image: ] indique un add-on dont la maintenance (correctifs et mises à jour) est officiellement assurée par la Fondation Blender ;


	
•[image: ] indique un add-on développé et maintenu par la communauté des utilisateurs de Blender.








Une fois installé manuellement, un add-on n’est pas actif pour autant : il est nécessaire de l’activer ! Il faut pour cela cocher la case qui accompagne sa description. Dès lors, il devient une fonction accessible par les menus appropriés de Blender : si vous dépliez la description complète de l’add-on installé, le chemin d’accès dans l’interface est généralement spécifié. Par exemple, l’add-on BoltFactory est accessible via le menu Add>Mesh>Bolt comme s’il s’agissait d’une primitive classique, ce qui montre les efforts d’intégration transparente qui ont été réalisés.


En théorie, cette activation n’est valable que pour le projet courant sur lequel vous travaillez : si vous l’avez sauvegardé, Blender se souviendra de l’activation de l’add-on à chaque réouverture du projet. Si vous souhaitez qu’un ou plusieurs add-ons soient disponibles dès la scène par défaut de Blender, il vous faut activer chacun d’eux et enregistrer les nouvelles préférences comme décrit dans l’aparté « Bon à savoir : Gestion des préférences utilisateurs », page 15.



Accélérer le rendu avec Cycles


L’une des principales innovations de Blender, ces dernières années, concerne Cycles, son moteur de rendu photoréaliste et physiquement exact. Toutefois, son principal inconvénient est la durée des rendus, qui est en théorie infinie. En effet, Cycles utilise exclusivement la technique du pathtracing pour calculer les images. Cette méthode consiste à simuler l’illumination globale de la scène en lançant des rayons de lumière qui vont progressivement générer l’image finale. Au début du calcul, l’image n’est constituée que d’un nuage de pixels qui va s’affiner progressivement jusqu’à former l’image finale. Concrètement, l’image calculée est de plus en plus nette, mais elle conservera toujours un léger grain. L’efficacité de l’algorithme dépend donc directement du nombre de rayons envoyés depuis la caméra.


Afin d’accélérer les calculs, Cycles permet d’utiliser la ou les cartes graphiques de votre ordinateur. En effet, le lancer de rayon est une méthode très facilement parallélisable, qui peut tirer un grand avantage de l’architecture fortement parallélisée des cartes graphiques modernes.


À titre comparatif, les processeurs haut de gamme destinés au grand public ont actuellement entre 16 et 64 cœurs, ce qui permet de lancer au maximum 64 rayons en parallèle pour le calcul de l’image. Les cartes graphiques modernes, quant à elles, comptent plusieurs centaines, voire des milliers de « cœurs », qui permettent de lancer autant de rayons en parallèle. Le choix est donc vite fait, et si vous possédez une carte graphique assez récente, elle vous sera indispensable pour éviter de longues heures de calcul.


Comment activer le rendu par GPU ?


L’activation du rendu par la ou les cartes graphiques se fait en deux étapes. Pour commencer, ouvrez les préférences utilisateur dans le menu Edit>Preferences, puis cliquez sur le dernier onglet System. Dans l’option Cycles Render Devices, choisissez CUDA ou OPTIX ou HIP et sélectionnez la ou les cartes graphiques que vous souhaitez utiliser pour le rendu. À noter qu’il est possible de combiner le rendu de la carte graphique avec celui du processeur en cochant toutes les options proposées.




[image: Figure 1–9 L’activation de la carte graphique se fait dans les préférences utilisateur.]


Figure 1–9
L’activation de la carte graphique se fait dans les préférences utilisateur.






De retour dans l’interface principale, dans l’onglet Render de la fenêtre des propriétés, puis dans l’option Device, choisissez GPU Compute.




[image: Figure 1–10 Activation du rendu GPU dans la fenêtre des propriétés]


Figure 1–10
Activation du rendu GPU dans la fenêtre des propriétés






Comment choisir sa carte graphique ?


À l’heure actuelle, deux constructeurs se partagent le marché des cartes graphiques, chacun proposant une technologie spécifique pour le calcul. Le leader du marché, Nvidia, embarque deux technologies Cuda et Optix dans ses cartes, alors que le challenger AMD préfère la technologie open source HIP. Historiquement, Cycles a toujours fonctionné avec Cuda et il était donc obligatoire d’avoir une carte de la marque Nvidia. Mais depuis quelques années, AMD développe des solutions compatibles avec Cycles. Il est cependant important de noter que les cartes de dernières générations Nvidia (RTX50xx) donnent actuellement les meilleures performances de calcul avec l’accélération Optix. À noter que deux outsiders ont récemment rejoint la compétition : Intel et Apple. Intel, avec ses cartes dédiées Arc, propose une API d’accélération matérielle nommée oneAPI et Apple propose sa propre technologie Metal. L’avantage technique de la technologie Metal est la gestion de la mémoire unifiée pour le rendu (RAM et VRAM sont confondues) ce qui permet le chargement rapide de scènes très lourdes.


Caractéristiques techniques


Le choix d’un nouveau matériel est toujours extrêmement technique et de nombreux paramètres entrent en compte. Dans le cadre d’une utilisation de Cycles, l’un des paramètres les plus importants à considérer sera la quantité de VRAM que la carte embarque. Comptez au minimum 4 Go pour pouvoir travailler confortablement, 16 si vous travaillez avec des scènes plus lourdes. Il n’y a pas de limite maximale à la quantité de VRAM, les capacités des cartes augmentant de génération en génération.


L’autre choix important est bien sûr le nombre de cœurs logiques de la carte graphique. Plus cette dernière en possède et plus le rendu sera rapide.


Enfin, d’autres paramètres sont à prendre en compte, tels que la connectique de la carte graphique sur la carte mère. Assurez-vous d’avoir une carte mère compatible avec les dernières cartes graphiques. La consommation électrique de la carte est également importante, les rendus d’animation pouvant prendre plusieurs heures.




REMARQUE À propos des cartes graphiques professionnelles


Les deux constructeurs AMD et Nvidia proposent chacun une gamme de cartes graphiques dédiée aux usages professionnels. Si, sur le papier, ces cartes sont techniquement au-dessus de celles du marché grand public (certaines peuvent embarquer jusqu’à 64 Go de VRAM), elles ne sont pas forcément adaptées au fonctionnement de Cycles et l’utilisateur ne gagnera pas en performance sur le temps de rendu. Cela s’explique par le fait que les cartes professionnelles sont construites pour faire du calcul numérique comportant des nombres « flottants » (nombres avec des virgules). Or, toute la logique interne de Cycles ne manipule que des nombres entiers, rendant inutile la puissance de calcul des cartes « pro ».





Le rendu par GPU ne fonctionne pas


Il est possible que le rendu par GPU ne fonctionne pas. L’image devient alors complètement noire ou des messages d’erreur apparaissent à l’écran.


BON À SAVOIR
Carte graphique non compatible




Si Blender affiche le message « No compatible GPUs found for path tracing. Cycles will render on the CPU. », cela signifie que votre ordinateur ne possède pas de carte graphique reconnue et que le rendu se fera automatiquement sur le processeur.





La première chose à faire est de vérifier que les pilotes de votre carte graphique sont à jour et que celle-ci est supportée par Cycles. Pour les cartes Nvidia, cela signifie que vous devez avoir une carte supportant Cuda 2.0 au minimum.


Si vous obtenez un message comme celui-ci : « CUDA error: Out of memory in cuLaunchKernel(cuPathTrace, xblocks, yblocks, 1, xthreads, ythreads, 1, 0, 0, args, 0) », il est probable que vous ayez dépassé la quantité de VRAM disponible dans votre carte graphique. La scène ne peut donc pas être chargée entièrement dans celle-ci, ce qui empêche toute possibilité de rendu.


Le gestionnaire d’assets


Depuis la version 4.0, un nouveau concept a été mis en place pour la gestion des bibliothèques de données externes. L’idée derrière ce gestionnaire d’assets est de regrouper la gestion de tous les éléments externes qui peuvent être utilisés régulièrement sur plusieurs projets. Les assets sont donc des modèles 3D, des matériaux, mais aussi des collections d’objets, des environnements ou encore des brosses pour le Sculpt Mode ou le Grease Pencil. Par défaut Blender s’installe avec des assets, mais il est bien sûr possible de rajouter des catalogues d’assets depuis les préférences utilisateurs, onglet File Path. En cliquant sur le bouton +, on pointe vers un dossier sur le disque qui sera la racine du catalogue. Blender va alors scanner tous les fichiers .blend qui se trouvent dans ce dossier ou dans les éventuels sous-dossiers. Dans chaque fichier, Blender va repérer les assets qui s’y trouvent et les rendre accessibles depuis n’importe quel fichier Blender via la fenêtre Asset Browser.




[image: Figure 1–11 Un exemple de catalogue d’images HDRI dans l’Asset Browser]


Figure 1–11
Un exemple de catalogue d’images HDRI dans l’Asset Browser








BON À SAVOIR
Définir un asset


Pour définir un asset, il suffit de faire un clic droit sur le nom de l’asset et de choisir Mark as Asset. Cela peut se faire dans l’Outliner, dans l’éditeur de matériau ou dans la fenêtre des propriétés. Une fois réalisé, si le fichier courant est dans un dossier défini comme catalogue, l’asset apparaîtra dans n’importe quel fichier Blender.




[image: Figure 1–12 En faisant un clic droit sur le nom d’un matériau, on peut le transformer en asset.]


Figure 1–12
En faisant un clic droit sur le nom d’un matériau, on peut le transformer en asset.
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Prise en main de Blender
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Restée longtemps bien spécifique dans sa catégorie, l’interface de Blender a su évoluer pour se montrer désormais plus intuitive et moins déconcertante aux yeux des nouveaux utilisateurs. Ce chapitre vous présentera les principaux éléments cachés ou visibles de son interface, et vous aidera à l’adapter à vos besoins. Dans ce chapitre, vous explorerez pas à pas l’interface de Blender, et comment vous en servir. Vous découvrirez en particulier les différentes vues, leur manipulation, l’utilisation des raccourcis clavier et surtout, de la souris.




[image: Still fourteen! © 2024, Boris Fauret]


Still fourteen! © 2024, Boris Fauret






L’interface de Blender est remarquable et unique à plus d’un titre. Elle peut paraître complexe et déroutante au premier abord mais elle se révèle extrêmement simple et productive par la suite. Simple, car une fois familiarisé avec la logique de l’organisation des données et des boutons de Blender dans un menu (par exemple, les matériaux), on se rend compte que ces données et ces boutons existent et fonctionnent selon la même logique dans d’autres menus. Par exemple, on remarque rapidement que la création de tout nouveau matériau ou de toute nouvelle texture (voir les chapitres 6 et 7) repose chaque fois sur un même principe. De même, dans un autre registre, l’édition d’un maillage dans la vue 3D, l’édition d’une F-Curve dans l’éditeur de graphes ou le dépliage d’une carte UV dans l’éditeur d’images reposent sur des manipulations étonnamment semblables. Et il en va de même pour la plupart des menus, ce qui démontre la robustesse et la consistance de l’interface.


L’interface de Blender est également qualifiée de productive car tout est pensé pour vous simplifier les manipulations et, surtout, vous faire gagner du temps. Les commandes se veulent immédiatement accessibles, de plusieurs façons différentes, satisfaisant ainsi probablement votre approche particulière de la modélisation ou de l’animation selon que vous soyez, par exemple, un adepte des raccourcis clavier, des icônes ou de l’usage des menus. Depuis les premières versions, les raccourcis clavier et les combinaisons de touches ont occupé dans Blender une place prépondérante, voire incontournable, permettant de réaliser très rapidement des actions particulièrement complexes par une simple succession de raccourcis clavier. Malheureusement, le fait de devoir mémoriser la trentaine de combinaisons absolument essentielles a largement contribué à forger la réputation de Blender, dont on parlait, il y a quelques années, comme d’un logiciel complexe et difficile à maîtriser, surtout pour les débutants, qui parfois n’arrivaient à rien en tirer !


Depuis, les choses ont évolué, car les développeurs de Blender ont pris en compte les demandes de leurs utilisateurs et se sont efforcés d’améliorer l’ergonomie de l’interface au travers d’icônes, de menus et sous-menus, et de boutons organisés d’une façon rationnelle (et parfois un peu trop proche de certains modèles commerciaux concurrents), tout en préservant la multiplicité des raccourcis clavier qui en ont fait toute la force.


REMARQUE La règle à retenir absolument




La règle d’or de Blender n’a jamais changé en plusieurs années d’existence ; si vous souhaitez en tirer le meilleur parti : « Une main sur le clavier, une main sur la souris ».


En effet, la plupart des raccourcis clavier peuvent être effectués d’une seule main et appellent une action en retour à la souris. En gardant cette règle en mémoire à chaque instant de votre travail avec Blender, vous constaterez que votre souris fera considérablement moins d’allers-retours entre les boutons, les menus et les autres recoins de l’interface graphique, pour se concentrer sur la seule chose qui doit vraiment retenir votre attention : la scène sur laquelle vous travaillez. Vous économiserez du temps, vous vous fatiguerez moins et vous serez plus efficace et plus productif.






Découverte de l’interface graphique


L’écran d’accueil


Dès le démarrage de Blender, l’écran d’accueil offre des fonctionnalités pouvant aider l’utilisateur à démarrer plus facilement :




	
•La section NewFile présente une collection d’espaces de travail différents, spécifiques selon vos besoins, lorsque vous commencez un projet. Ils sont bien évidemment modifiables et peuvent être réorganisés à votre guise à tout moment :


	
–General est l’agencement par défaut et permet rapidement d’accéder à toutes les fonctions de Blender ;


	
–2D Animation est dédié à l’animation de vos illustrations réalisées avec le Grease Pencil, un des récents outils puissants de Blender. Il existe un environnement pour toutes les étapes : dessin/animation, composition et rendu ;


	
–Sculpting ouvre Blender directement sur une vue 3D spécialement adaptée à la sculpture numérique avec une sphère prête à être modelée ;


	
–VFX est spécifiquement paramétré pour le travail d’incrustation d’effets spéciaux et comprend donc un environnement pour les étapes de tracking, de mise en place de masques, de compositing et de rendu ;


	
–Video Editing permet, comme son nom l’indique, d’ouvrir Blender sur un environnement dédié à l’édition de vidéos.







[image: Figure 2–1 L’écran d’accueil présente des fonctionnalités qui aident l’utilisateur à démarrer plus rapidement son activité.]


Figure 2–1
L’écran d’accueil présente des fonctionnalités qui aident l’utilisateur à démarrer plus rapidement son activité.








	
•La section Recent Files présente une liste des derniers fichiers .blend qui ont été ouverts.


	
•La fonction Open permet d’ouvrir vos fichiers de type .blend.


	
•La fonction Recover Last Session permet de restaurer la session précédente non sauvegardée. Utile en cas de crash inopiné de Blender.


	
•Deux liens : le premier renvoie vers la note de mise à jour (Release Note) de cette version de Blender et le second vers la page de donation, vous permettant de participer au financement du fonds de développement.





ASTUCE
Affichage plein écran




Il est possible d’afficher Blender en mode plein écran (sans aucune décoration de fenêtre issue du système sur lequel Blender est lancé) grâce au menu Window>Toggle Window Fullscreen.




[image: Figure 2–2 Cette fonction permet d’afficher Blender en mode plein écran.]


Figure 2–2
Cette fonction permet d’afficher Blender en mode plein écran.









La figure 2-3 présente l’interface de Blender lors de son premier démarrage. Dans son état actuel (nous verrons en effet très prochainement comment personnaliser cet affichage), nous pouvons identifier six zones distinctes.




	
•La barre principale : elle est située tout en haut de l’écran, juste sous la barre de titre du logiciel. Elle présente les menus communs à de nombreux logiciels comme la gestion des fichiers, de l’édition, de l’affichage. Vous noterez également des onglets qui permettent de basculer d’un environnement de travail à un autre.


	
•La barre d’information : située tout en bas, elle donne à tout moment des options possibles en fonction de l’outil utilisé (à gauche) et de la version de Blender utilisée (à droite). Il vous est également possible d’y faire apparaître les statistiques utiles sur le contenu de la scène et la quantité de mémoire utilisée par celle-ci (à droite). Pour cela, faites un clic droit sur la barre d’information et cochez les options souhaitées (Scene Statistics, System Memory, Video Memory).


	
•La vue principale : elle est actuellement occupée par une vue 3D, avec au pied de celle-ci les menus et les boîtes à outils disponibles pour ce type de vue. Une boîte à outils verticale (escamotable) occupe son extrémité gauche.


	
•L’éditeur des propriétés : il s’agit de la zone réservée à l’interface graphique permettant de paramétrer les objets de Blender ; au sommet de celle-ci se trouvent les icônes qui permettent d’organiser les boutons par familles. Il s’agit en fait d’une vue à part entière.


	
•L’Outliner : il présente une vision hiérarchique des objets et blocs de données qui constituent la scène courante (cela est particulièrement utile pour les scènes complexes).


	
•La Timeline : dans le cadre d’une animation ou d’une simulation, cette vue permet de se repérer sur la ligne temporelle de la scène et d’y naviguer.





BON À SAVOIR
Raccourcis universels




Certains raccourcis clavier sont disponibles quelle que soit la position du curseur de la souris, à l’exception (pour certains) de l’éditeur de texte. Par exemple, les touches suivantes sont toujours associées à l’action correspondante :




	
•[Ctrl]+[Q] : quitter Blender ;


	
•[Ctrl]+[O] : ouvrir un fichier ;


	
•[Ctrl]+[S] : sauvegarder un fichier ;


	
•touche [F12] : lancer le rendu de la scène.








Si vous survolez une vue avec la souris, l’en-tête de cette vue s’éclaircit légèrement afin de vous prévenir qu’il s’agit de la vue active. Les raccourcis clavier que vous pourriez utiliser n’affecteront que la vue active. En d’autres termes, pour utiliser un raccourci clavier censé affecter le contenu de la vue 3D, le pointeur de la souris devra se trouver dans celle-ci.




[image: Figure 2–3 L’interface de Blender, lors de son démarrage]


Figure 2–3
L’interface de Blender, lors de son démarrage








BON À SAVOIR Blender et les en-têtes


Les en-têtes sont paramétrables. En faisant un clic droit dessus, un menu apparaît pour vous permettre de le placer en haut ou en bas de la fenêtre (option Flip to Top/Bottom). Vous pouvez également choisir de masquer les menus qui s’y trouvent en décochant l’option Show Menu, voire de masquer l’en-tête lui-même en décochant l’option Show Header, auquel cas l’en-tête disparaît, laissant place à une petite flèche cliquable si vous voulez le dérouler à nouveau.







ASTUCE Faire défiler le contenu de l’en-tête


Les en-têtes sont les barres de menus qui se situent soit en haut, soit en bas d’un éditeur ou d’une vue. Ils présentent des menus, des icônes et des fonctions qui sont souvent propres au type d’éditeur.


Lorsque le contenu de l’en-tête (menus et icônes) est plus large que l’espace qu’il décore, il est possible de faire glisser son contenu de gauche à droite, soit en utilisant la molette de la souris (le pointeur se trouvant sur l’en-tête), soit en maintenant appuyé le bouton central de la souris et en déplaçant celle-ci de gauche à droite.





Vous noterez que chaque en-tête commence par une icône qui permet de déterminer le type d’éditeur à afficher dans la vue en question. En cliquant dessus, un menu déroulant apparaît pour vous permettre de choisir le contenu affiché par la vue.




[image: Figure 2–4 Les types de vues disponibles à l’affichage]


Figure 2–4
Les types de vues disponibles à l’affichage






Il est évident que nous ne pourrons pas faire le tour complet et exhaustif de toutes les entrées de menu ou de tous les boutons des différents panneaux. Nous tâcherons, en revanche, d’aller à l’essentiel et de vous permettre d’être rapidement productif, en répondant aux interrogations les plus courantes. Cela ne voudra pas dire que les éléments passés sous silence sont inutiles, mais simplement qu’il est moins urgent d’apprendre à les maîtriser.


La barre principale


Le menu File permet de réaliser des opérations très courantes sur les fichiers. En particulier, nous noterons les fonctions suivantes :




	
•New supprime la scène courante et la remplace par la scène par défaut ;


	
•Open... permet d’ouvrir une scène existante ;


	
•Save sauvegarde la scène avec le nom de fichier courant ;


	
•Save as... sauvegarde la scène sous un nouveau nom ;


	
•Append importe un élément précis d’une scène existante (disponible sur l’un de vos périphériques) vers la scène courante ;


	
•External Data est un sous-menu qui offre plusieurs options afin de faciliter les échanges de fichiers entre utilisateurs de Blender. Parmi les options les plus importantes, on distingue :


	
•Pack All Into .blend, qui enregistre les textures et les images en même temps que la scène ;


	
•Unpack All Into Files, qui est l’opération inverse et qui permet d’extraire les textures et les images de la scène ;


	
•Make All Paths Relative et Make All Paths Absolute, qui sont des fonctions utiles pour le transfert de fichiers d’un répertoire à l’autre du même ordinateur, dans le cas où les fonctions de packing (distribution des textures et images directement avec le fichier .blend) ne sont pas utilisées.





ASTUCE
Les fonctions de capture de la vue 3D




Vous trouverez dans le menu View de l’en-tête de la vue 3D deux options intéressantes, autant pour les auteurs de documentation ou de didacticiels que pour les simples usagers à la recherche d’aide dans les forums des diverses communautés utilisatrices de Blender, pour exposer plus facilement ses soucis :




	
•Viewport Render Image, qui permet de faire un rendu OpenGL de la vue active ;


	
•Viewport Render Animation, qui permet de capturer en OpenGL une animation en train de se jouer dans la vue active ; il s’agit d’une forme de prévisualisation très économique, en temps de rendu, d’un projet d’animation.








Le menu Render centralise des fonctions de rendu, autrement disponibles dans certains panneaux de la fenêtre des boutons et/ou au travers de raccourcis clavier. Un passage par la fenêtre des boutons est cependant indispensable pour régler les paramètres de rendu. Parmi les options de ce menu, nous retiendrons plus particulièrement :




	
•Render Image, qui lance le rendu de l’image courante, selon les paramètres prédéfinis dans les boutons de rendu, et qui correspond au raccourci clavier [F12] ;


	
•Render Animation, qui lance le rendu de l’animation entière, selon les paramètres indiqués dans les boutons de rendu, et qui correspond au raccourci clavier [Ctrl]+[F12] ;


	
•View Render, qui permet d’afficher la dernière image rendue et qui correspond au raccourci clavier [F11] ;


	
•View Animation, qui rejoue sous forme d’animation les images rendues individuellement grâce à l’option Render Animation et qui correspond au raccourci clavier [Ctrl]+[F11].





Le menu Window permet de gérer la fenêtre de Blender, notamment avec la possibilité de basculer en plein écran (Toggle Window Fullscreen), d’afficher ou masquer la barre d’information (option Show Status Bar) ou encore la possibilité de passer à l’environnement de travail suivant ou précédent.


Le menu Help, enfin, propose de l’aide à l’utilisateur, au travers de scripts Python qui vont lancer le navigateur par défaut de votre système pour accéder à des ressources particulièrement intéressantes d’Internet. Il est à noter que ces ressources sont en anglais, des traductions existant parfois pour certaines d’entre elles mais pas en accès direct. Vous retrouverez, en particulier, la documentation de Blender et des didacticiels pour vous aider à maîtriser certaines fonctionnalités.




[image: Figure 2–5 La barre principale de Blender : à gauche, le menu et à droite, les espaces de travail.]


Figure 2–5
La barre principale de Blender : à gauche, le menu et à droite, les espaces de travail.






À droite du menu, vous trouvez les onglets des environnements de travail. Ceux-ci permettent de basculer aisément d’un agencement de vues dédiées à une tâche particulière – à un autre. Dans le cas d’un nouveau fichier de type General choisi à l’ouverture de Blender, vous trouverez les environnements suivants :




	
•Layout



	
•Modeling



	
•Sculpting



	
•UV Editing



	
•Texture Paint



	
•Shading



	
•Animation



	
•Rendering



	
•Compositing



	
•Scripting



	
•+






Chacun de ces espaces de travail est évidemment modifiable selon vos besoins ou vos préférences.



La barre d’information


La barre d’information située tout en bas de l’interface affiche diverses informations sur Blender et la scène active. Selon l’outil sélectionné, cette barre affiche d’abord les options accessibles via la souris ou des raccourcis clavier. Viennent ensuite d’autres informations qui ne sont pas affichées par défaut. Pour activer l’affichage de ces informations, faites un clic droit sur la barre d’information et cochez les options (Scene Statistics, System Memory, Video Memory, Blender Version). Elles diffèrent légèrement selon que l’objet est en cours d’édition ou non.


Hors du mode Edit :




	
•Collection indique quelle collection est active ;


	
•[nom] indique le nom de l’objet actuellement sélectionné ;


	
•Verts indique le nombre de sommets (constituant les maillages) présents dans la scène ;


	
•Faces indique le nombre de faces (constituant les maillages) présents dans la scène ;


	
•Tris : que l’objet soit constitué de triangles, de quadrangles ou de polygones à plus de quatre côtés, au moment du rendu, chaque polygone est converti en triangles ; ce paramètre indique le nombre de triangles résultant de cette conversion pour l’objet donné ;


	
•Objects indique le nombre d’objets sélectionnés par rapport au nombre d’objets présents dans la scène (lampes et caméra comprise) ;


	
•Mem indique la consommation instantanée de mémoire et, entre parenthèses, le pic de consommation observé lors de la session de travail ;


	
•VRAM indique la quantité de mémoire vidéo utilisée par votre scène ;


	
•[numéro de version] indique la version de Blender utilisée.





En mode Edit, certaines informations apparaissent avec des variantes utiles, propres à l’objet édité :




	
•Verts : le premier nombre indique le nombre de sommets sélectionnés, et le second, le nombre de sommets total de l’objet ;


	
•Edges : le premier nombre indique le nombre d’arêtes sélectionnées, et le second, le nombre d’arêtes total de l’objet ;


	
•Faces : le premier nombre indique le nombre de faces sélectionnées, et le second, le nombre de faces total de l’objet ;





ASTUCE
Faire défiler le contenu des menus




En fonction de la taille de votre écran, il se peut que les statistiques de la scène, qui s’affichent tout à fait à droite du menu général, soient partiellement tronquées. Vous pouvez cliquer (molette de la souris) sur le menu général et le faire défiler de gauche à droite afin d’afficher une extrémité ou l’autre du menu général, comme n’importe quel menu de n’importe quelle fenêtre.







[image: Figure 2–6 L’affichage des statistiques complètes de l’objet sélectionné]


Figure 2–6
L’affichage des statistiques complètes de l’objet sélectionné







La vue principale


Par défaut, il s’agit d’une vue 3D, mais cela peut être tout autre type de vue, en fonction du choix opéré par l’utilisateur, en cliquant sur l’icône tout à gauche de l’en-tête. Comme la barre de menus principale, la vue principale propose en permanence l’icône permettant de changer le type de vue, un menu qui s’adapte de façon contextuelle au type de vue et une série d’icônes, également différentes d’un type de vue à l’autre.


REMARQUE
Les types de vue à découvrir rapidement




Tous les types de vue sont bien évidemment utiles, mais certaines vues sont utilisées plus fréquemment que d’autres. Pour accélérer votre apprentissage de Blender, autant vous y intéresser le plus tôt possible.


Vous utiliserez de façon transparente le File Browser à chaque fois que vous voudrez charger ou sauvegarder un projet ou une image ; 3D View et Properties vous accompagneront chaque jour ; Graph Editor et Video Sequence Editor seront mis en œuvre en même temps que vos premières animations. Par la suite, vous gagnerez du temps grâce à l’Outliner, qui sera utile à vos projets les plus importants, et Preferences, qui vous permettra de démarrer directement avec votre configuration préférée de Blender. Enfin, le Shader Editor et le Compositor vous permettront de tirer parti de la création de matériaux par boîtes logiques, ou du compositing vidéo.





Les différentes vues possibles sont les suivantes, de haut en bas dans le menu :




	
•3D Viewport, une vue qui permet de visualiser les objets d’une scène et de les éditer individuellement. C’est la vue par défaut de Blender, à laquelle nous apporterons une attention particulière dans ce chapitre.


	
•Image Editor, une vue qui permet de gérer les images utilisées dans votre projet (textures, références, etc.). Il est également possible de créer une image de A à Z grâce aux outils de peinture numérique intégrés.


	
•UV Editor, une vue qui permet de contrôler le dépliage d’un maillage pour le faire correspondre à une image existante ou non. La puissance des outils de dépliage de Blender est l’un de ses plus grands atouts.


	
•Shader Editor, une vue qui permet de créer vos matériaux grâce un réseau de boîtes de fonctions que vous reliez entre elles suivant les effets que vous souhaitez obtenir. Vous constituez ainsi un réseau, dont les boîtes sont les nœuds. Il existe bien sûr des nœuds de différents types offrant des possibilités quasi illimitées.


	
•Compositor, une vue qui permet de créer à partir de votre rendu une image composite. Comme la vue Shader Editor, son mode de fonctionnement est nodal, c’est-à-dire basé sur des boîtes de fonctions appelées nœuds. Vous y trouverez d’ailleurs de nombreuses fonctions communes.


	
•Texture Node Editor, un éditeur nodal qui permet d’éditer les textures utilisées. Particulièrement utile si vous avez une brosse à motif (pour sculpter, par exemple) et que vous souhaitez ajuster finement la texture attribuée à celle-ci.


	
•Video Sequencer, une vue qui permet de composer une animation complète à partir de scènes rendues par Blender, de vidéos importées ou même simplement de séquences d’images fixes. Le séquenceur propose des effets très avancés, comme des transitions plus ou moins sophistiquées, ou des effets spéciaux conçus pour renforcer le réalisme de vos images (fixes comme animées), comme le flou focal ou l’éblouissement. La versatilité de cet éditeur est l’un des plus grands atouts de Blender.


	
•Movie Clip Editor, une vue dans laquelle sont préparées les opérations de tracking vidéo, afin de synchroniser les mouvements des caméras issues des environnements réels et virtuels (incrustation d’éléments 3D dans des films traditionnels).


	
•DopeSheet, une vue qui permet de visualiser les positions clés d’une animation, qu’il s’agisse de celles d’un objet, d’une armature ou des déformations relatives d’un maillage.


	
•Timeline, une vue qui permet de contrôler finement la façon dont une animation est jouée, autorisant jusqu’à l’édition de clés ou de paramètres, par exemple d’un Material (matériau), pendant l’animation même. L’animation peut bien sûr être jouée au ralenti et des marqueurs peuvent être posés pour accéder plus rapidement à des séquences nécessitant un contrôle plus fin de l’animation.


	
•Graph Editor, une vue qui permet de définir certains paramètres d’un objet (que ce soient des propriétés d’un objet de type Material, de position, de rotation, etc.) en fonction du temps, à l’aide de courbes de variation aux profils aisément paramétrables (courbes de Bézier, segments, etc.). C’est un outil très simple qui permet la réalisation d’animations complexes.


	
•Drivers, une vue qui permet d’établir des pilotes pour contrôler, via un système de graphes, comment les objets peuvent s’influencer dans le cadre d’une animation.


	
•Nonlinear Animation (NLA) Editor, une vue qui offre un éditeur permettant de contrôler l’animation d’armatures (dans le cas d’animations sous forme de squelettes de personnages, par exemple) ou les clés de déformation relative des maillages (pour l’animation des expressions du visage d’un personnage, par exemple) de tous les objets en spécifiant l’enchaînement de leurs positions clés.


	
•Text Editor, une vue qui offre un petit éditeur de texte embarqué dans Blender. Cet éditeur autorise la coloration syntaxique, l’indentation automatique et d’autres raffinements du même type. Lorsque vous écrirez un script Python pour Blender, vous passerez soit par un éditeur externe de votre choix (avant d’importer le script dans Blender), soit par cette vue.


	
•Python Console, une vue qui fait office d’environnement Python, essentiellement à destination des auteurs des add-ons (greffons écrits en Python).


	
•Info, une vue qui retrace par écrit les opérations exécutées, les messages d’erreurs et les avertissements.


	
•Outliner, une vue qui permet d’afficher sous forme d’arborescence les éléments constituant la scène, en respectant la hiérarchie de celle-ci. Ainsi, l’élément Scene Collection est parent d’un objet Cube, lui-même parent d’un maillage, lui-même parent d’un Material, lui-même parent d’une Texture et ainsi de suite pour tous les objets de la scène. Il est possible de développer ou masquer tout ou partie d’une branche de l’arborescence en cliquant sur les petits boutons flèche en face de chaque entrée.


	
•Properties, une vue qui offre la possibilité d’afficher les boutons servant à utiliser ou paramétrer les objets créés dans Blender. Les boutons sont regroupés par panneaux et onglets dans des catégories cohérentes symbolisées par les icônes placées dans l’en-tête de la vue.


	
•File Browser, une vue qui permet de naviguer dans le système de fichiers de votre ordinateur. Dans la liste de fichiers, les lignes blanches symbolisent des répertoires, et les lignes noires des fichiers. Les fichiers précédés d’un carré jaune sable indiquent des fichiers natifs de Blender. Cette vue ne peut véritablement servir à des opérations sur fichiers que lorsqu’elle est appelée au travers de fonctions comme Open (touche [F1]) ou Save As... (touche [F2]).


	
•Preferences, une vue qui permet de définir, pour la scène courante, les préférences de l’utilisateur dans différents domaines. Les catégories disponibles sont, par exemple, les chemins par défaut dans lesquels Blender ira chercher les textures, les scripts ou l’enregistrement des rendus ou des animations.





À DÉCOUVRIR RAPIDEMENT
L’éditeur des propriétés




Les propriétés Material et Texture sont indispensables à maîtriser pour donner une apparence crédible ou intéressante à vos objets. Dans le même ordre d’idées, les propriétés Object cachent de nombreux réglages en fonction du type de l’objet sélectionné dans la vue 3D, par exemple les propriétés des lampes, indispensables à la production d’éclairages satisfaisants. Les propriétés Modifiers sont de précieuses aides à la génération interactive d’objets ou d’effets d’animation avancés dépendant du type d’objet sélectionné dans la vue 3D. Les propriétés Render, enfin, vous permettront de régler les options et d’effectuer le rendu de vos scènes.





L’éditeur des propriétés (Properties)


Avec la vue 3D standard, il s’agit du plus important type de vue de Blender. C’est là qu’il est possible de paramétrer la totalité des fonctionnalités de Blender. Et même si quelques possibilités et fonctionnalités peuvent être reprises par certaines icônes ou certains menus, l’éditeur des propriétés est résolument incontournable.


L’éditeur des propriétés est accompagné d’une barre de navigation latérale composée d’icônes. Il est particulier dans le sens où l’action sur l’une ou l’autre des icônes modifiera la catégorie des propriétés affichées. Les quinze catégories sont les suivantes :




	
•Active Tool and Workspace Settings permet de régler l’outil sélectionné et de paramétrer la vue principale de l’environnement de travail dans lequel vous vous trouvez ;


	
•Render Properties permet de choisir le moteur de rendu à utiliser et de régler les différents paramètres qui lui sont propres ;


	
•Output Properties permet de définir les dimensions d’une image de rendu, le framerate éventuel dans le cadre d’une animation, le format de sortie de l’image/animation (JPEG, PNG, AVI…) ou encore son chemin de sortie ;


	
•View Layer Properties permet de gérer les calques de rendu, afin d’inclure ou d’exclure à volonté les éléments de votre scène qui apparaîtront sur l’image finale ;


	
•Scene Properties permet de déterminer l’environnement de rendu en définissant une caméra active, une image d’arrière-plan ou un film d’arrière-plan, ainsi que de préciser les options de gestion de sons, la définition des unités dans Blender, la valeur de la gravité pour les simulations physiques et des options de simplification des scènes afin de générer des rendus de prévisualisation plus rapides ;


	
•World Properties permet de donner à vos images des arrière-plans intéressants, du simple dégradé à l’image photographique, de mettre en place des étoiles ou des effets de brume, ou encore de simuler une illumination globale grâce aux méthodes dites de l’occlusion ambiante ou de l’illumination indirecte ;


	
•Collection Properties permet de gérer les propriétés des collections (groupes d’objets que vous créez) notamment en termes d’affichage au rendu et d’interaction avec les autres objets de la scène.


	
•Object Properties permet une gestion globale de l’objet en récapitulant ses paramètres de transformation, les calques où il apparaît ainsi que les relations avec les autres objets, son appartenance à un groupe, ses options d’affichage dans la vue 3D, ses options d’animation le long de chemin ou ses règles de duplication ;







[image: Figure 2–7 Les icônes des différentes catégories de propriétés]


Figure 2–7
Les icônes des différentes catégories de propriétés








	
•Modifiers Properties permet de transformer de façon interactive la forme des objets, en leur adjoignant un ou plusieurs modificateurs. Ces modificateurs peuvent affecter le maillage de l’objet, en générant ou supprimant de la géométrie, la forme de l’objet, en déformant celui-ci, ses interactions et sa réponse aux systèmes de simulation de Blender ;


	
•Particles Properties permet d’assigner un système de particules à un objet ainsi que, bien sûr, de paramétrer leurs comportements ;


	
•Physics Properties permet de définir si l’objet est à prendre en considération dans les simulations physiques ou s’il doit être ignoré, que ce soit en tant qu’acteur ou « réacteur ».


	
•Object Constraints Properties permet d’attribuer à l’objet des contraintes qui seront très utiles lors des animations. Ces contraintes peuvent affecter les transformations de l’objet, les méthodes de tracking d’autres objets, les relations parent-enfant avec les autres objets, ainsi que le tracking des mouvements ;


	
•Object Data Properties s’adapte au type d’objet sélectionné, offrant une icône ainsi que des propriétés qui diffèrent selon qu’il s’agisse, par exemple, d’un maillage, d’une caméra ou d’une lampe ;


	
•Material Properties, dont les propriétés ne sont disponibles que pour les objets acceptant un matériau, comme les objets maillés. Ces propriétés permettent de contrôler les paramètres généraux d’un matériau du point de vue du moteur de rendu mais aussi de gérer les textures qui lui sont rattachées, comme la pigmentation, la transparence sélective ou la simulation de défauts de surface ;


	
•Texture Properties permet de définir les textures utilisées avec certains modificateurs (comme Displace) ou bien celle utilisées pour personnaliser vos brosses dans les modes de peintures que Blender offre. En aucun cas ce menu ne gère les textures que vous attribuerez aux matériaux de vos objets.





LE SAVIEZ VOUS ?
Spécifier une valeur précise




L’interface de Blender présente de très nombreux boutons permettant assez souvent de spécifier une valeur numérique, soit grâce à de petites flèches, soit grâce à une jauge (à déplacer comme un curseur). Vous pouvez utiliser le bouton gauche de la souris pour cliquer sur la valeur courante du bouton, ce qui édite celle-ci et vous permet d’entrer au clavier la valeur précisément souhaitée. Vous pouvez également saisir une expression mathématique que Blender se chargera d’interpréter. Par exemple, si vous tapez 150*2, cela donnera pour résultat la valeur 300. Attention, certains champs n’acceptent pas les décimales et arrondiront donc le résultat de l’expression. Par exemple, 800/1,33 donnera 602 dans un champ, ou 601.504 dans un autre.





Personnaliser l’interface


Nous avons déjà vu qu’il est possible de changer une vue en n’importe quel autre type de vue. Mais souvent, vous souhaiterez également personnaliser votre espace de travail, pour l’adapter à vos habitudes et à vos préférences, mais aussi à votre matériel, comme la résolution de votre écran.


ASTUCE
Émulation du troisième bouton de la souris




Dans la vue Preferences ou par le menu Edit>Preferences, observez les boutons relatifs à la catégorie Input. Ils permettent entre autres possibilités de personnaliser le comportement de la souris et, en particulier, d’activer le bouton Emulate 3 Button mouse. Une fois ceci fait, vous pouvez émuler le bouton central de la souris en cliquant simultanément sur les boutons gauche et droit de votre souris.





Partitionner les espaces de travail


Blender offre deux méthodes distinctes pour partitionner les espaces de travail.


Manipuler les bordures


Cliquez sur n’importe quelle bordure entre deux vues avec le bouton droit de la souris. Un menu contextuel apparaît avec plusieurs options :




[image: Figure 2–8 Le menu contextuel permettant de séparer ou de fusionner les vues]


Figure 2–8
Le menu contextuel permettant de séparer ou de fusionner les vues






ASTUCE
Déplacer l’en-tête ou maximiser une vue




En cliquant sur un en-tête avec le bouton droit de la souris, vous pouvez choisir entre plusieurs options, notamment basculer l’en-tête à l’opposé de sa position actuelle et maximiser la vue de sorte qu’elle occupe la fenêtre entière de Blender. Veuillez noter que le raccourci [Ctrl]+[Espace] permet de basculer à volonté entre les vues normale et maximisée lorsque le curseur de la souris est positionné dans la vue concernée.




[image: Figure 2–9 L’option Flip to Bottom permet, par exemple, de basculer l’en-tête en bas de la vue lorsqu’il se trouvait précédemment en haut de celle-ci.]


Figure 2–9
L’option Flip to Bottom permet, par exemple, de basculer l’en-tête en bas de la vue lorsqu’il se trouvait précédemment en haut de celle-ci.











	
•Les options Vertical Split ou Horizontal Split permettent de couper en deux l’une des vues. Une ligne de séparation apparaît sur le pointeur de la souris. La touche [Tab] permet de basculer entre séparation horizontale ou verticale avant la validation. Le bouton gauche permet de valider la séparation, tandis que le bouton droit permet d’annuler l’opération.


	
•L’option Join Right/Left permet de fusionner les deux vues séparées par la bordure sur laquelle l’opération est réalisée, soit vers la droite, soit vers la gauche. Comme précédemment, le bouton droit permet d’annuler l’opération.


	
•L’option Swap Areas permet d’échanger l’emplacement des deux vues situées de part et d’autre de la bordure sur laquelle l’opération est déclenchée.






Manipuler les coins des éditeurs


Chaque éditeur présente des coins arrondis qui permettent de partitionner ou de fusionner les espaces de travail. L’apprentissage de cette fonctionnalité demande un peu d’habitude mais se révèle extrêmement pratique à l’usage.




[image: Figure 2–10 Le coin arrondi permet de déclencher les actions de partitionnement des vues.]


Figure 2–10
Le coin arrondi permet de déclencher les actions de partitionnement des vues.








[image: Figure 2–11 Lors de l’opération de fusion, le curseur s’adapte et propose d’écraser l’une des deux vues avec l’autre.]


Figure 2–11
Lors de l’opération de fusion, le curseur s’adapte et propose d’écraser l’une des deux vues avec l’autre.






Dans tous les cas, il convient de positionner le pointeur de la souris sur le coin. Il se transforme alors en curseur en forme de croix verticale, indiquant qu’une action est prête à être déclenchée. L’utilisateur presse (et maintient) le bouton gauche de la souris et l’action résultante dépend alors de son mouvement :




	
•horizontalement ou verticalement vers le reste de la vue en cours : un partitionnement commence ; l’utilisateur définit la position du séparateur entre les deux espaces en déplaçant la souris puis en relâchant le bouton lorsqu’il est satisfait ;


	
•horizontalement ou verticalement vers une vue jouxtant la vue en cours : une fusion commence (si celle-ci est possible) ; l’utilisateur doit ensuite désigner la fenêtre qui disparaîtra à la suite de l’opération de fusion, lorsqu’il aura relâché le bouton.





Bien évidemment, il peut redimensionner à volonté un espace existant en déplaçant (bouton gauche de la souris pressé) une frontière sur laquelle est positionné le pointeur de la souris.


L’opération Swap Areas peut également être réalisée depuis cette zone. En maintenant la touche [Ctrl] pressée, lorsque le pointeur de la souris est positionné sur le coin arrondi d’un éditeur (et en forme de croix), l’utilisateur peut utiliser et maintenir le bouton gauche de la souris pour attraper l’éditeur et le déposer dans un autre éditeur. Les positions des deux éditeurs sont alors interverties.




ASTUCE Détacher un espace de travail en fenêtre indépendante


Les artistes modernes travaillent fréquemment avec plusieurs écrans, sur lesquels ils aiment bien regrouper les outils d’un côté, par exemple, et les éditeurs ou la vue 3D de l’autre. Ils apprécieront le cas échéant de pouvoir détacher un espace de travail en fenêtre indépendante qu’ils pourront déplacer sur un second écran. La manipulation consiste à maintenir la touche [Maj] enfoncée, à cliquer avec le bouton gauche de la souris sur le coin (une fois le pointeur transformé en curseur en forme de croix verticale) et à déplacer la souris dans n’importe quelle direction. Cette opération est également possible en faisant un clic droit sur l’en-tête de la vue souhaitée, puis en choisissant Duplicate Area Into New Window dans le menu qui apparaît.





Sauvegarder les préférences


Si vous avez mis en place un agencement de vues qui vous satisfait, vous pouvez l’enregistrer grâce au menu File>Defaults>Save Startup File. Blender affichera une demande de confirmation.




[image: Figure 2–12 Demande de confirmation pour l’enregistrement des préférences]


Figure 2–12
Demande de confirmation pour l’enregistrement des préférences






Notez toutefois que si vous avez modifié la scène par défaut (activation de certains boutons dans la fenêtre des boutons, ajout de lampes, d’objets ou de caméras dans la vue 3D, etc.), toutes ces modifications seront également sauvegardées, vous permettant ainsi de personnaliser jusqu’à la scène de démarrage par défaut.


ASTUCE
Restaurer la configuration d’origine




Pour restaurer la configuration d’origine, il faut passer par le menu File> Defaults> Load Factory Settings, qui vous propose de tout réinitialiser ; vous n’avez qu’à confirmer puis, sans rien toucher à la scène nouvellement restaurée, utilisez le menu File>Defaults>Save Startup File pour que la nouvelle scène redevienne votre préférence utilisateur.





La vue 3D


Il s’agit de la vue dans laquelle vous réaliserez, normalement, le plus d’opérations lors de l’usage de Blender. Une attention particulière lui est donc apportée mais la plupart des vues disposent de petits raffinements plus ou moins dissimulés ou documentés.


Notions de repères


La scène peut être considérée comme un espace vide, avec une origine considérée comme le centre de « l’univers ». À partir de ce centre sont définies trois directions absolues : la direction X et la direction Y, perpendiculaires entre elles, qui définissent le plan horizontal, et la direction Z, perpendiculaire au plan horizontal, qui définit la notion d’altitude.


Dans la vue 3D de Blender, le plan horizontal est matérialisé sans ambiguïté par une grille traversée par une direction X rouge et une direction Y verte.


Dans le coin supérieur droit de la vue 3D, un petit repère orthonormé aide à la visualisation, en adjoignant notamment aux deux directions X et Y la troisième direction Z qui représente l’altitude par rapport à la grille.




[image: Figure 2–13 L’« univers » de Blender se résume à une origine, au centre d’une grille horizontale, et à trois directions absolues.]


Figure 2–13
L’« univers » de Blender se résume à une origine, au centre d’une grille horizontale, et à trois directions absolues.






Naviguer dans l’espace


Il ne s’agit pas ici de déplacer les objets dans la vue, mais bien de se déplacer dans celle-ci, ou plus exactement de modifier le point de vue. La scène n’est en rien affectée par les manipulations ci-après, seule sa représentation à l’écran l’est.


REMARQUE
Vue active




Les opérations qui suivent ne fonctionnent que dans la vue active. À noter que la vue active est toujours celle dans laquelle se trouve le pointeur de la souris.





Faire tourner la vue


À noter que le pivot de la rotation est le centre de la vue.




	
•À la souris : en cliquant sur le bouton central de la souris et en le maintenant appuyé, la vue se met à tourner autour du point pivot selon les déplacements de la souris. La position du curseur de la souris au moment du clic est importante, car sa distance par rapport au point pivot définit l’amplitude du mouvement et, par conséquent, sa précision.


	
•Au clavier : utilisez les flèches directionnelles du pavé numérique, c’est-à-dire les touches [4], [6], [2] et [8] pour faire tourner la vue respectivement vers la gauche, la droite, le bas et le haut, toujours autour du point pivot, bien entendu.






Translater la vue


Il s’agit de translater la vue, opération également connue sous le nom de panning, dans son propre plan, afin de réaliser un mouvement panoramique.




	
•À la souris : appuyez sur la touche [Maj] puis cliquez et maintenez le bouton central de la souris pour translater la vue selon les déplacements de la souris.


	
•Au clavier : associez la touche [Ctrl] aux flèches directionnelles du pavé numérique, c’est-à-dire les touches [4], [6], [2] et [8], pour translater la vue respectivement vers la gauche, la droite, le bas ou le haut.





ASTUCE
Perdu dans l’espace ? Pas de panique...




Si vous vous perdez, pour avoir trop zoomé ou translaté la vue, utilisez tout simplement la combinaison [Maj]+[C] qui va automatiquement recentrer la vue sur la scène, de sorte que vous puissiez la visionner dans sa globalité.


La touche [.] du pavé numérique est particulièrement utile car elle permet de centrer la vue sur l’objet actif sélectionné.


Attention à la touche [/] du pavé numérique, qui est un faux ami : elle permet de centrer et zoomer la vue sur l’objet actif sélectionné, tout comme la touche [.], mais elle masque tous les objets de la scène à l’exception de l’objet actif ! Il s’agit toutefois d’une touche « bascule » et l’employer à nouveau devrait rétablir l’affichage des autres objets de la scène.





Zoomer ou dézoomer


L’opération de zoom est centrée par défaut sur le point pivot de la vue.




	
•À la souris : appuyez sur la touche [Ctrl], puis cliquez et maintenez le bouton central de la souris, pour zoomer ou dézoomer dans la vue 3D. Vous pouvez également utiliser la molette de la souris pour cette opération.


	
•Au clavier : les touches [+] et [-] permettront respectivement de zoomer et de dézoomer dans la vue 3D.





ASTUCE
Afficher les vues opposées




De la même façon que les touches [7], [1] et [3] permettent respectivement d’afficher les vues de dessus, face et droite de la scène, la combinaison [Ctrl]+ la même touche numérique en affiche la vue opposée. Ainsi, [Ctrl]+[7] affiche la « vue de dessous », [Ctrl]+[1] la « vue de derrière » et [Ctrl]+[3] la « vue de gauche » !





Gestion des vues


Blender propose des vues prédéfinies dont l’usage facilite souvent la visualisation et/ou la mise en place ou la modélisation des objets. Ces vues sont accessibles grâce aux touches du pavé numérique.




	
•Touche [7] : permet d’afficher la « vue de dessus » de la scène.


	
•Touche [1] : permet d’afficher la « vue de face » de la scène.


	
•Touche [3] : permet d’afficher la « vue de droite » de la scène.


	
•Touche [0] : permet d’afficher le point de vue de la caméra active.





À noter que le fait d’appuyer sur la touche [5] du pavé numérique permet de basculer alternativement du mode d’affichage en perspective au mode d’affichage orthogonal. L’affichage en perspective tient compte des lignes de fuite vers l’horizon et fait que les objets au premier plan paraîtront plus gros que des objets de même taille situés « plus loin » en arrière-plan, comme dans la réalité. En mode orthogonal, il n’y a pas de ligne de fuite. En conséquence, les objets sont tous représentés en « vraie grandeur », quelle que soit la distance qui les sépare du point d’observation.


ASTUCE Changer la caméra active




Si vous n’avez qu’une caméra dans votre scène, en appuyant sur la touche [0] du pavé numérique, vous affichez toujours la scène selon le point de vue de cette caméra. Si, au contraire, vous avez plusieurs caméras dans votre scène, vous pouvez définir la caméra active en sélectionnant celle-ci, et en appuyant sur la combinaison de touches [Ctrl]+[0]. Dès lors, à chaque fois que vous changerez de vue en appuyant sur la touche [0] du pavé numérique, vous afficherez la scène du point de vue de la nouvelle caméra active.


Veuillez noter que n’importe quel objet peut se transformer en caméra : il suffit de le sélectionner et d’utiliser la même combinaison [Ctrl]+[0]. La vue de caméra aura alors pour origine l’origine de l’objet, et pour orientation, l’orientation propre de l’objet.





Affichage de la scène


Par défaut, la scène est affichée en mode « solide » et ombré (Solid) mais parfois, ce mode ne permet pas une bonne visualisation lorsque plusieurs objets sont placés les uns derrière les autres. En appuyant sur la combinaison de touches [Maj]+[Z], la vue ombrée est remplacée par une vue filaire (Wireframe) qui facilite notamment le placement des objets les uns par rapport aux autres.




[image: Figure 2–14 Les différents modes d’affichage dans la vue 3D]


Figure 2–14
Les différents modes d’affichage dans la vue 3D






En fait, des icônes dans le coin supérieur droit de la vue 3D permettent de modifier l’affichage de la vue 3D, en offrant plusieurs autres modes. La touche [Z] permet également de choisir l’un de ces modes.




	
•Wireframe : il s’agit du mode de visualisation en fil de fer, permettant de bien juger des volumes respectifs des différents objets de la scène. En mode orthogonal, il permet de positionner fidèlement les objets de la scène les uns par rapport aux autres, à la même altitude par exemple. C’est une méthode d’affichage économique en puissance de calcul.


	
•Solid : cette méthode d’affichage, qui est celle utilisée par défaut dans Blender, consomme un peu plus de puissance de calcul mais permet d’ombrer (et de rendre opaques !) les objets de votre scène, rendant moins confuse la visualisation de la scène. L’ombrage est toutefois virtuel et ne tient pas compte des lampes positionnées dans votre scène. Seuls les matériaux habillent les objets ; les textures sont absentes.


	
•Material Preview : les textures UV de vos objets apparaissent dans la vue 3D. De plus, l’ombrage des objets prend en compte le positionnement des lampes dans la scène. Un environnement par défaut est attribué pour donner plus de contenance aux matériaux créés. Bien évidemment, cette méthode d’affichage consomme encore plus de puissance.







[image: Figure 2–15 Chaque mode d’affichage présente des options propres, accessibles par le menu déroulant. Ici, l’environnement utilisé dans le mode Material Preview est modifié en quelques clics.]


Figure 2–15
Chaque mode d’affichage présente des options propres, accessibles par le menu déroulant. Ici, l’environnement utilisé dans le mode Material Preview est modifié en quelques clics.








	
•Rendered : dans ce type d’affichage, c’est le moteur de rendu qui se charge de calculer progressivement l’image finale, affinant celle-ci jusqu’à un nombre limité d’échantillons. Les processeurs (y compris ceux de la carte graphique si le matériel est compatible) sont fortement mis à contribution par ce mode d’affichage.





Le mode d’affichage sélectionné peut être paramétré grâce au bouton « flèche » situé juste à droite des icônes de sélection (figure 2-15). À noter que pour le mode Rendered, ce sont bien évidemment les options établies dans l’onglet Render Properties de l’éditeur de propriétés qui seront prises en compte.


Le curseur


Pour définir une nouvelle position du curseur dans la scène, il suffit de sélectionner l’outil [image: ], puis de cliquer à un endroit de la vue 3D avec le bouton gauche de la souris : le curseur s’y repositionne immédiatement. Pour plus d’efficacité, sans avoir à changer d’outil, il sera souvent judicieux d’utiliser la combinaison de touches [Maj]+[bouton droit] pour parvenir au même résultat. Dorénavant, tout nouvel objet inséré dans la scène apparaîtra avec son origine très exactement positionnée sur le curseur.


Attention, car le choix de la vue est important : l’usage des vues classiques (dessus, face et droite) est recommandé la plupart du temps en mode orthographique, le curseur étant positionné dans le plan de la vue et la vue en perspective pouvant fausser la précision du positionnement du curseur.




[image: Figure 2–16 Positionnement du curseur]


Figure 2–16
Positionnement du curseur








ASTUCE Positionnement spécifique du curseur


L’usage de la combinaison de touches [Maj]+[S] appelle une fenêtre Snap dont les options suivantes peuvent particulièrement vous intéresser à cette étape.




	
•Cursor to Selected : positionne le curseur sur le centre de la sélection actuelle (identique à Cursor to Active lorsqu’un seul objet figure dans la sélection).


	
•Cursor to World Origin : positionne le curseur au centre exact de la scène 3D.


	
•Cursor to Grid : permet de positionner le curseur exactement sur la plus proche intersection de la grille.


	
•Cursor to Active : positionne le curseur à l’origine de l’objet actuellement actif.







[image: Figure 2–17 Le menu Snap, qui permet le positionnement précis du curseur.]


Figure 2–17
Le menu Snap, qui permet le positionnement précis du curseur.










Les menus latéraux masqués


La vue 3D s’assortit de deux menus optionnels qui peuvent être invoqués en cliquant sur le petit bouton « flèche » inscrit dans un rond blanc dans les coins supérieurs gauche et droit. Les menus s’adaptent au mode de la vue pour l’un et au type d’éditeur pour l’autre mais dans les deux cas, nous nous intéresserons principalement au cas de la vue 3D qui est la plus largement utilisée de tous les éditeurs.


L’étagère à outils


Ce menu optionnel peut être fermé (ou réouvert) grâce à la touche [T] (pour Toolshelf) dans la vue 3D ou grâce au bouton > dans le coin supérieur gauche. Son contenu s’adapte en fonction du mode de la vue 3D ; il regroupe, par exemple, de façon très pratique les outils relatifs aux modes objet (Object Mode) ou édition (Edit Mode), mettant à portée de souris les opérations les plus courantes dans chacun de ces deux modes. Bien sûr, il s’adapte instantanément à tous les autres modes possibles de la vue 3D, affichant aussi bien les outils de sculpture, en Sculpt Mode, que les brosses de peinture, en mode Texture Paint ou Vertex Paint.


Également très pratique, tout en bas de la vue 3D, se trouve un onglet déroulant qui affiche les paramètres relatifs à l’outil en cours d’usage. Tant qu’une autre opération n’est pas effectuée, il est possible d’actionner une option ou l’autre, et de visionner interactivement le résultat dans la vue 3D. Ces réglages interactifs sont particulièrement attrayants pour les utilisateurs débutants qui doivent tâtonner un peu pour trouver les réglages qui leur conviennent. Le même menu est invoqué avec la touche [F9] immédiatement après avoir réalisé une opération.




[image: Figure 2–18 Contenu de l’étagère en mode Object]


Figure 2–18
Contenu de l’étagère en mode Object








[image: Figure 2–19 Extrait des outils disponibles, en mode Edit]


Figure 2–19
Extrait des outils disponibles, en mode Edit






Le panneau des propriétés numériques


Ce menu optionnel peut être fermé (ou réouvert) grâce à la touche [N] (pour « numérique ») dans la vue 3D ou grâce au bouton < dans le coin supérieur droit. Son contenu varie en fonction du type d’éditeur. Dans la vue 3D, en Object Mode, il donne en particulier accès à une variété d’onglets.




	
•L’onglet Item permet de visualiser ou de modifier au clavier les coordonnées de localisation (Location), de rotation (Rotation) ou d’échelle (Scale) de l’objet sélectionné, mais aussi de verrouiller les directions de transformation grâce aux cadenas associés à chaque coordonnée X, Y ou Z ! Vous pouvez également y spécifier ses dimensions.


	
•L’onglet Tool offre un espace supplémentaire pour paramétrer l’outil sélectionné. Vous y retrouvez en effet les mêmes options de réglages que dans la catégorie Active Tool and Workspaces Settings de l’éditeur de propriétés.


	
•View : permet de simuler un objectif (Lens) différent pour la vue 3D lorsqu’elle est en perspective, ou de spécifier la plage sur laquelle le contenu de la scène s’affiche (Clip). Il est également possible de verrouiller la vue 3D sur un objet spécifique qui restera au centre de celle-ci (Lock To Object) ou de spécifier au clavier la position du curseur 3D (3D Cursor Location).





Bases fondamentales


Blender a la réputation d’être un logiciel difficile à prendre en main. Même si techniquement les développeurs en ont tenu compte et travaillent régulièrement tout aussi bien sur les fonctionnalités que sur l’ergonomie, cette mauvaise réputation a la vie dure. Pourtant, une fois acquises les quelques bases qui suivent, la découverte de Blender par soimême est tout à fait possible et se révèle même très plaisante.




[image: Figure 2–20 Le panneau des propriétés numériques]


Figure 2–20
Le panneau des propriétés numériques






Ajout d’un objet dans la scène


Le menu Add qu’on retrouve dans l’en-tête de la vue 3D permet d’insérer dans la scène des objets de différentes natures. Certains sont « matériels », dans le sens où ils apparaîtront sur l’image finale, comme les types Mesh, Surface et Meta, d’autres sont en revanche « immatériels » comme les types Empty, Camera et Light.




	
•Mesh insère un maillage de géométrie prédéfinie, comme un cube, une sphère, un cône et quelques autres encore.


	
•Curve permet d’insérer des courbes de Bézier ou des NURBS, ainsi que des chemins d’animation.


	
•Surface insère des primitives de modélisation surfaciques, comme le tube, la sphère ou le tore, mais aussi, et surtout, l’élément de surface.


	
•Metaball insère des primitives qui ont la propriété de s’agglomérer les unes aux autres comme de la glaise ou du mercure. Plusieurs formes sont disponibles parmi lesquelles la sphère, le cylindre, le cube et l’ellipsoïde.


	
•Text permet d’insérer un texte en 3D.


	
•Grease Pencil insère un objet 2D dessiné (voir chapitre 12, page 497).


	
•Armature insère le premier os d’un squelette d’animation.


	
•Lattice est une cage de déformation, utile pour animer facilement des formes simples ou déformer des formes complexes.


	
•Empty est un objet vide mais disposant malgré tout d’un centre, d’une localisation, d’une échelle et d’une orientation. Il s’agit en fait d’un compagnon indispensable de bon nombre d’animations !





LE SAVIEZ-VOUS ?




La tête de singe qu’on obtient en choisissant Add>Monkey s’appelle Suzanne et est devenue la mascotte de Blender. Elle est à Blender ce que la théière est à 3ds Max : un terrain d’expérimentation pour paramètres ou fonctionnalités exotiques !




[image: Figure 2–21 Suzanne : mascotte de Blender]


Figure 2–21
Suzanne : mascotte de Blender











	
•Image permet d’ajouter une image en arrière-plan (non rendue) pour servir, par exemple, de référence dans le cadre d’une modélisation.


	
•Light, presque aussi indispensable que la caméra, représente la lampe qui éclaire votre scène.


	
•Light Probe, spécifique au moteur de rendu Eevee, est un type d’objet qui permet de précalculer l’éclairage indirect.


	
•Camera, indispensable à toute scène, représente la caméra et permet de définir l’angle de vue du rendu.


	
•Speaker est un objet vide, à rapprocher de Empty, qui spécifie un point virtuel d’émission pour un son et dont la spatialisation sera prise en compte par Blender lorsque ce dernier jouera le son.


	
•Force Field est un objet vide, à rapprocher de Empty, qui est une source de perturbations diverses (vent, champ magnétique, vortex, etc.) pour vos simulations physiques ou vos systèmes de particules.


	
•Collection Instance permet de dupliquer à la position du curseur le contenu d’une collection préexistante.





ASTUCE
Aligner les objets lors de leur ajout




Par défaut, lorsqu’un nouvel objet est ajouté à la scène, il est aligné sur le monde (world). Par exemple, un objet Cone apparaîtra avec sa pointe orientée vers les Z positifs. Il est toutefois possible de modifier ce comportement par défaut de Blender et d’imposer que tout nouvel objet apparaisse aligné sur la vue courante. Ainsi, la base de notre Cone d’exemple apparaîtrait avec sa base dans le plan de la vue, la pointe tournée vers l’utilisateur, perpendiculaire à la vue.


Pour modifier ce comportement, allez dans le menu Edit>Preferences et dans l’onglet Editing, choisissez Align To : View à la place de World. Il peut arriver que d’une version à l’autre de Blender, le comportement par défaut soit changé : vous aurez alors à modifier ce réglage si la modification ne vous satisfait pas.





Il est souvent plus productif d’utiliser la combinaison de touches [Maj]+[A] dont la fonction est justement d’appeler le menu spécial Add, que d’utiliser le menu de l’en-tête de la vue 3D. Dans tous les cas, l’objet choisi est inséré dans la scène à la position indiquée par le curseur.




BON À SAVOIR Créer et gérer des collections d’objets


Il est possible de créer des collections et de leur assigner différents objets. Les raisons d’utiliser de telles collections sont variables et dépendent des habitudes de travail des artistes ou des animateurs. Il peut s’agir notamment de regrouper des objets spécifiques au sein d’une même « sélection permanente », en cas d’usages ultérieurs répétés ; de favoriser l’import,  via la fonction Append, d’un ensemble spécifique d’objets en une seule fois plutôt que par imports successifs ; ou encore d’ajouter à la position du curseur (Add>Collection Instance) un groupe déjà créé et présent dans la scène.


Sélectionnez un premier objet et utilisez la combinaison [Ctrl]+[G] ou, dans l’onglet Object Properties de l’éditeur des propriétés, cliquez sur l’icône « plus » à droite du bouton Add to Collection. Un nouveau panneau permettant de nommer la collection nouvellement créée fait son apparition et la « croix » à droite du nom permet de supprimer l’objet du groupe en question. Il est bien sûr possible d’assigner un objet à plusieurs groupes différents : avec l’objet sélectionné, il suffit de cliquer sur le bouton Add to Collection et de choisir dans le menu déroulant le nom du groupe existant de votre choix, pour qu’il y soit assigné.







[image: Figure 2–22 Le menu Add, accessible depuis le menu ou la combinaison [Maj]+[A]]


Figure 2–22
Le menu Add, accessible depuis le menu ou la combinaison [Maj]+[A]






Sélection des objets


De nombreuses fonctions de Blender opèrent sur des objets sélectionnés. Pour sélectionner un objet, cliquez dessus avec le bouton gauche de la souris. Dans la vue 3D, l’objet sélectionné apparaît surligné en orange clair.


Vous pouvez ajouter d’autres objets à la sélection, en maintenant la touche [Maj] pressée lorsque vous utilisez le bouton gauche de la souris. Tous les objets ajoutés successivement apparaissent surlignés en orange foncé, et seul le dernier ajouté à la sélection apparaît en orange clair : il s’agit de l’objet actif.


Si vous n’avez pas sélectionné les objets dans un ordre particulier, vous pouvez définir l’un des objets sélectionnés comme l’objet actif en maintenant la touche [Maj] pressée et en utilisant le bouton gauche de la souris pour le désigner.


ASTUCE
Tout sélectionner ou désélectionner




La touche [A] permet de sélectionner tous les objets de la scène (en mode Object) ou tous les sommets d’un objet (en mode Edit). Pour tout désélectionner, utilisez la combinaison de touches [Alt]+[A]. Ces deux raccourcis sont opérationnels dans la plupart des éditeurs de Blender.







LE SAVIEZ-VOUS ? Sélection par le bouton droit


Jusqu’à la version 2.80, Blender optait pour la sélection avec le bouton droit, le bouton gauche servant à déplacer le curseur 3D. Cette disposition, allant à l’encontre de ce qui se fait dans la plupart des logiciels, a pendant longtemps rebuté beaucoup de nouveaux utilisateurs. Par souci d’uniformité, cette convention n’a donc été que très récemment abandonnée.


En allant dans le menu Edit>Preferences, dans l’onglet Keymap, il est néanmoins toujours possible de forcer la sélection avec le bouton droit en activant l’option Select with Mouse Button>Right. Ce changement n’aura certainement pour justification que la curiosité. Attention toutefois, le bouton gauche est alors utilisé pour déplacer le curseur 3D, et toutes les opérations de sélection/désélection avec le bouton gauche, que ce soit dans cet ouvrage ou dans les documentations récentes disponibles sur Internet, sont dès lors inversées.




[image: Figure 2–23 Choix du bouton de sélection par défaut de la souris]


Figure 2–23
Choix du bouton de sélection par défaut de la souris









ASTUCE
Sélection par relation




Vous pouvez sélectionner un unique objet et utiliser la combinaison [Maj]+[G] : un menu apparaît vous proposant de sélectionner d’autres objets selon différents critères. Par exemple, si vous sélectionnez Collection, tous les objets appartenant à la même collection seront sélectionnés en même temps. D’autres options sont possibles, parmi lesquelles :




	
•Children, pour sélectionner tous les enfants de cet objet ;


	
•Parent, pour sélectionner le parent de l’objet à la place de celui-ci ;


	
•Type, pour sélectionner tous les objets du même type (par exemple, le type Camera ou le type Mesh).





Vous pouvez opérer les mêmes sélections en passant par le menu de la vue 3D : Select>Grouped qui offre alors les mêmes options de sélection groupée.







BON À SAVOIR Éditer un objet au sein d’une sélection


Le dernier objet ajouté à la sélection est l’objet actif et il apparaît surligné d’un orange plus clair que les autres.


Le fait qu’il soit actif veut dire qu’il peut être édité de plusieurs façons, par exemple :




	
•dans la vue des Propriétés, l’onglet Object Data Properties s’adapte à sa nature selon que c’est un maillage, une caméra, une lampe… ;


	
•dans l’en-tête de la vue 3D, il est possible de basculer de l’Object Mode par défaut à l’Edit Mode, par exemple, si la nature de l’objet actif est compatible avec ce mode.





Lorsque vous éditez un objet au sein d’une sélection, Blender conserve le contenu de cette sélection en mémoire mais autorise malgré tout l’édition de l’objet actif sans pour autant affecter les autres objets de la sélection.
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